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About Electronic Signatures
The ability to sign files electronically will reduce the time and cost associated with routing hard copy doc-
uments for wet signatures. Project participants are provided with instant access to signed documents and 
improved visibility of process statuses. The most common need for eSignatures are in contract approval pro-
cesses and the like.  

Electronic signatures allow users to integrate DocuSign or Adobe Acrobat Sign Enterprise accounts with their 
Trimble Unity Construct account in order to prepare documents and have recipients electronically sign PDF 
files either in a Trimble Unity Construct workflow or via direct email from those providers. This feature is sup-
ported through the Processes module.

How Trimble Unity Construct uses e-Signature
 l e-Signature sessions are embedded within our powerful Process/ Workflow module ensuring that users 

do not have to exit Trimble Unity Construct to prepare or sign documents.
 l The Trimble Unity Construct Admin determines which workflow step makes the most sense to have 

staff prepare documents by tagging specific e-Signature locations on those documents.
 l e-Signature recipients that are not Trimble Unity Construct users will receive a direct email requesting 

their signature, which is then uploaded to the Process/ Workflow.
 l Trimble Unity Construct users on workflow steps requiring e-Signature, receive the documents in 

proper sequence and e-Sign each document exactly where required.

Note: A DocuSign license or an Adobe Acrobat Sign enterprise account is required in order to use the eSig-
nature feature in Trimble Unity Construct.

Steps in the eSignature Process
 1. Authentication of the DocuSign or Adobe Acrobat Sign Enterprise account: The DocuSign 

account or Adobe Acrobat Sign enterprise account must first be authenticated  in Trimble Unity Con-
struct before they can be used in eSignature process instances. 
For DocuSign clients, following successful authentication, Trimble Unity Construct Admins must notify 
Trimble Support and Support will then activate OAuth 2.0 authentication on future DocuSign process 
instances. Adobe Acrobat Sign clients can begin using Acrobat Sign immediately after authentication.
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 2. Configure the eSignature Workflow: For each file data field that will contain a document to be 
signed, ensure that the Destination File Data Field settings are configured correctly on the Data Field 
eSignature Settings section of the Data tab. (Setup> Administration Tools> Processes> Manage Pro-
cesses> {Click on a process name to view it} > Data Tab) 

Data Field eSignature Settings

Account administrators can include prepare document and e-Signing actions on Trimble Unity Con-
struct workflow steps. These actions may be added to new or existing workflow steps. Admins can also 
create roles for signees. Any user that is an actor on the signing step can be a signatory. 

 3. Document Preparation: User(s) in document preparation roles can open Adobe Acrobat Sign or 
DocuSign, add form fields and tag documents for eSignature by internal and external recipients. 
Acrobat Sign does not allow removal of recipients once the agreement is no longer in Draft status, there-
fore it is imperative that any recipients who will not be necessary for a given process instance be 
removed initially.

 4. Completing the eSignature Process: Recipients can electronically sign the document and then com-
plete the eSignature step to send the process to the next workflow step. 

Documents that are signed by Trimble Unity Construct step actors are saved in the Documents module 
as soon as the signing action is taken for quick and convenient retrieval. Documents that are signed by 
recipients who are not step actors as well as any step actors are automatically uploaded to Trimble 
Unity Construct's Documents module when the workflow completes the eSignature Download auto-
mation step. Each signed document is added as an electronic "envelope" in the client's DocuSign 
account, or as an electronic "agreement" in the client's Adobe Acrobat Sign account. Envelopes and 
agreements are encrypted with GUIDs, which certifies them as unique, electronically signed files.

e-Signature Integration
Adobe Acrobat Sign or DocuSign accounts must be authenticated in Trimble Unity Construct before they can 
be used in the e-Signature process. 

Adobe Acrobat Sign Authentication

A "Group Administrator" on your organization’s Adobe account must authorize and authenticate your 
Trimble Unity Construct account to your Adobe Acrobat Sign enterprise account at the group level.
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Note: Your Adobe Account Admin must first set up a group that will be dedicated to storing Trimble Unity 
Construct generated agreements.

Group Administrators can make updates to the Group Setup, Group Settings, and Group Send Settings in 
their organization's Adobe account to maximize the user experience with Trimble Unity Construct e-Sig-
natures. This eliminates the previous requirement for Adobe Account Admins to make changes to their 
Global Settings to maximize the integration.

Any agreements created through Trimble Unity Construct's e-Signature sessions will be stored within the 
group and can be managed at the group-level.

To authenticate the Adobe Acrobat Sign integration

 1. Click Setup. 

If the Setup tab is not visible, click , and then select the  Setup check box.

 2. In the Administration Tools menu, expand Processes.
 3. Click e-Signature. The e-Signature Integration page will be displayed.

 4. Click Authenticate to sign into your Acrobat Sign account. The Adobe Acrobat Sign Log In page will 
be displayed.
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 5. In the Email field, enter your email address.
 6. In the Password field, enter your password and click Sign In.
 7. You will be asked to confirm whether you wish to allow access to Adobe Acrobat Sign from Trimble 

Unity Construct. 

Tip: If you are not ready to authenticate, click Cancel. If you click Cancel, a warning message will 
be displayed mentioning that consent has not been granted.

 8. Click Allow Access to confirm. An Authorization Successful message will be displayed. 

To remove the Adobe Acrobat Sign integration authentication

 1. Click Setup. 

If the Setup tab is not visible, click , and then select the  Setup check box.

 2. In the Administration Tools menu, expand Processes.
 3. Click e-Signature. The e-Signature Integration page will be displayed.
 4. Click Remove. You will be asked to confirm whether you want to remove the integration with Adobe 

Acrobat Sign.
 5. Click Yes, Remove to confirm. The integration will be removed.

DocuSign Authentication

DocuSign accounts must be authenticated in Trimble Unity Construct before they can be used in the e-Sig-
nature process.

Clients with Single Sign On (SSO) portals:

If access to DocuSign account requires login to your SSO portal, first have your DocuSign system user 
login to SSO, then DocuSIgn before authenticating.

Important: Following successful authorization, Trimble Unity Construct Admins must notify Trimble Sup-
port and Support will then activate OAuth 2.0 authentication on future DocuSign process instances.

To authenticate the DocuSign integration

 1. Click Setup. 

If the Setup tab is not visible, click , and then select the  Setup check box.
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 2. In the Administration Tools menu, expand Processes.
 3. Click e-Signature. The e-Signature Integration page will be displayed.

 4. Click Authenticate. The DocuSign Log In page will be displayed.
 5. In the Email field, enter your email address and click Next.
 6. In the Password field, enter your password and click Log In.
 7. You will be asked to confirm whether you wish to allow access to DocuSign from Trimble Unity Con-

struct. 

Tip: If you are not ready to authenticate, click Cancel. If you click Cancel, a warning message will 
be displayed mentioning that consent has not been granted.

 8. Click Allow Access to confirm. An Authorization Successful message will be displayed. 

Note: While authenticating the DocuSign integration with Trimble Unity Construct, users with mul-
tiple DocuSign accounts will be asked to select the account that they would like to integrate with 
Trimble Unity Construct. After selecting the DocuSign account, click Confirm to save the 
changes.

To remove the DocuSign integration authentication

 1. Click Setup. 

If the Setup tab is not visible, click , and then select the  Setup check box.
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 2. In the Administration Tools menu, expand Processes.
 3. Click e-Signature. The e-Signature Integration page will be displayed.
 4. Click Remove. You will be asked to confirm whether you want to remove the integration with 

DocuSign.
 5. Click Yes, Remove to confirm. The integration will be removed.

Configure the eSignature Process 
The following additional process and system configurations may be required to support the electronic sig-
nature feature in Trimble Unity Construct.

Step 1: Create Roles for Signees

Since the actions that can be taken on each step are role based, a valid role must exist for the signee or 
potential signees of the eSignature step. 

Creating a role with specific users is a two-step process. You must first create the role, and then add users 
to the role. 

Note: As you select a role for the signing step, ensure that it includes only those persons that are allowed 
to sign the document. Otherwise, all actors in the selected role will have the ability to sign.

To create a role for each signee or sets of signees
 1. Click Setup to access Administration Tools.
 2. Click Users > Manage Roles.

The Manage Roles page is displayed.

 3. Click Add Role.
 4. Enter a name for this role in the Name field.

Example: A naming convention might be <Process Name>, <Step Name>.

 5. Optional: Enter a description in the Description field.
 6. Select Yes if this is an administration role. 
 7. Click Save.

To add users to the role
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 1. Click the name of the account role.
 2. Click Add User To Role.
 3. Filter for users and then select the check box next to the user's name.
 4. Click Add User.

Step 2: Create File Data Fields for File Upload

File data fields make it possible for actors to upload documents. The same or different file data fields can be 
used to point to the destination folder of your choice. 

Note: If you already have file data fields created that can be incorporated into your eSignature process, 
then this task is not required. Complete this task only if you do not already have the appropriate file data 
fields available.

Tip: Create a file data field for the upload of the final document as well. This way, you can store the final 
signed document in the appropriate location, perhaps in a limited-access folder.

To create a file data field
 1. Go to the  Data Tab for the process.
 2. Click Add Field.

The Add Data Field page is displayed.

 3. Select the File radio button, and then click Next.
 4. Complete all necessary fields.
 5. Select the destination folder of the file in the Destination Folder Path field. If you do not choose 

a folder, users will have to choose one at the time of upload.
 6. Click Next. 

 A preview of the field just created is displayed on the field summary page.
 7. Click Save or Save & Add to create another data field.

Step 3: Create String Data Field for Final Document

Create a string data field that will be used in the script added to the automation step of your eSignature pro-
cess. 

Note: It is recommended that you do not use an existing field or reuse it for other purposes within a single 
process.

To create a string data field
 1. Go to the Data tab of the process. 
 2. Click Add Field.
 3. Select the String radio button, and then click Next.
 4. Complete all necessary fields.

access_data_tab.htm
access_data_tab.htm
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Note: The field can be given any name, but “DownloadSuccess” is recommended so that our 
Support team can easily locate it when finalizing this process for you, or if troubleshooting 
becomes necessary.

 5. Click Next. The field summary page displays a preview of the field just created.

 6. Click Save or Save & Add to create another data field.

Step 4: Configure eSignature Data Field Settings

eSignature data field settings allow administrators to specify the destination file data field, and a naming 
convention for the final version of the signed document.

To configure eSignature data field settings
 1. Go to the  Data tab for the process.

 2. For each file data field that will contain a document to be signed, click the adjacent Destination 
File Data Field drop-down menu to select the file data field that will be used as the destination 
folder for the signed document. When more than one Destination File Data field is mapped, only 
one of those files is required to prepare the document for eSignature. Users will no longer have to 
upload “placeholder” files in DocuSign process instances when more than one file field is 
mapped by Admin.

Note: This drop-down menu includes all existing file data fields. Files will go to the destination 
folder associated with the selected data field. To add or change the destination folder, edit the 
data field. If a folder is not specified, the user will be asked to make a selection when the file is 
uploaded. 

 3. In the Naming Convention field, enter a name to be appended to the end of the final document 
after all documents in the document set have been signed.

Example
If you use the suffix_signed and the name of the document is Trimble Unity Construct User 
Guide, the final version that includes all signatures will be called, Trimble Unity Construct 
User Guide_signed.

 4. Click Save eSignature Settings.

access_data_tab.htm
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Step 5: Create a Read-Only Layout (Optional)

Create a read-only layout to prevent modification of the documents that need signatures.

As a business rule, you may not want to give signatories the ability to modify the files they need to sign; how-
ever, in a revision step, you might. Create the read-only layout based on the business rules that govern the 
process.

To create a read-only layout
 1. Go to the Page Layouts tab of the process.
 2. Click Add Layout.
 3. Enter the name of the layout in the Layout Name field.
 4. Click Save.
 5. Select the data field on the right side of the page and drag into the Data section.
 6. Select the field so that it is highlighted.
 7. Right-click the highlighted field and select Edit Field Properties.
 8. Select the Read-Only check box, and then click Save.

The dialog box closes and you are now on the Layout Properties page.

 9. Click Save.

Step 6: Enable eSignatures

The eSignature feature is enabled on the action of a process step. There are two parts to this particular step 
of the configuration. You must create a signing action and a non-signing action in order to give the signee 
an alternate action in case they choose not to sign the document during a particular process instance.

Optionally, you can also allow user(s) in document preparation roles to open a Sending session to tag doc-
uments for eSignature by internal and external recipients. Document preparers can precisely tag locations 
on documents for eSignature by each recipient, eliminating any missed signatures or initials. Project stake-
holders who only interact with the construction program on rare occasions can be tagged as external recip-
ients so that no Trimble Unity Construct license or user training is necessary in order to perform 
eSignatures.

Tip: In some cases, the process initiator is the actor that uploads documents to the eSignature Source 
fields and then takes action to prepare documents for eSignature.  To make the workflow more efficient, 
documents can be prepared for eSignature from the Submit action on the Start step of the workflow. This 
will eliminate the requirement for Administrators to configure a subsequent Data Entry step that supports 
the Prepare Document for eSignature option. 

Note: On the Submit action for the Start step of the workflow,  only the Prepare Document(s) for eSig-
nature check box will be available for selection. The Require eSignature(s) check box option will not be 
available for the Submit action from the Start step.

Add a Signing Action

To add a signing action

access_page_layouts_tab.htm
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 1. Go to the Workflows tab of the process.
 2. Click the title of the workflow you want to access.
 3. Click Design Workflow. 
 4. Go to the Workflow Designer.
 5. To create a new step, drag and drop the Data Entry step to the Workflow Designer.

The Edit Step page is displayed.
—Or—
To modify an existing step, right-click the step, and then click Properties. The Edit Step page is 
displayed.

 6. Complete all necessary fields.
 7. To make the file read-only, select a read-only layout from the Actor Layout drop-down menu.
 8. Click Add Action.

The Add Action page is displayed.

 9. Complete all necessary fields.
 10. Select the Require Signature(s)? check box.

Note: Only one signature option, either the Prepare Document(s) for eSignature check box 
or the Require eSignature(s) check box can be enabled on a step action at a time. Once 
either check box has been selected, the other one will be greyed out and cannot be enabled.

 11. Select the signee's user role(s).

Note: All users within the selected role will have the ability to sign the document. To limit these 
users to the required signatories only, create a user role that includes only the qualified sign-
ees.

 12. Click Save.

Add an Alternate, Non-Signing Action

A non-signing action is required in order to give the actor an alternate action. A probable secondary 
action might be Decline or Revise and Resubmit, which could potentially kick start the process all over 
again.

Warning: If the same file or a new file is uploaded, the current envelope ID becomes void and a new 
envelope will have to be created. In this case, all previous signees will have to sign each file again. A 
single envelope can contain a number of documents.

To add a non-signing action

 1. Go to the Workflows tab of the process.
 2. Click the title of the workflow you want to access.
 3. Go to the Workflow Designer.
 4. To create a new step, drag and drop the Data Entry step to the Workflow Designer.

access_workflows_tab.htm
access_workflow_designer.htm
access_workflows_tab.htm
access_workflow_designer.htm
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The Edit Step page is displayed.
—Or—
To modify an existing step right-click the step, and then click Properties. The Edit Step page is 
displayed.

 5. Complete all necessary fields.
 6. To make the file read-only, select a read-only layout from the Actor Layout drop-down menu.
 7. Click Add Action.

The Add Action page is displayed.

 8. Complete all necessary fields, EXCEPT the Require Signature(s)? check box. Leave this check 
box clear.

 9. Select the signee's user role(s).

Note: All users within the selected role will have the ability to sign the document. To limit these 
users to the required signatories only, create a user role that includes qualified signees only.

 10. Click Save.

Add a Document Preparation Action (This is required for Adobe Acrobat Sign to function

To add a document preparation action

 1. Go to the Workflows tab of the process.
 2. Click the title of the workflow you want to access.
 3. Click Design Workflow. 
 4. Go to the Workflow Designer.
 5. To create a new step, drag and drop the Data Entry step to the Workflow Designer.

The Edit Step page is displayed.
—Or—
To modify an existing step, right-click the step, and then click Properties. The Edit Step page is 
displayed.

 6. Complete all necessary fields.
 7. To make the file read-only, select a read-only layout from the Actor Layout drop-down menu.
 8. Click Add Action.

The Add Action page is displayed.

 9. Complete all necessary fields.
 10. Select the Prepare document(s) for Signature(s)? check box.

Note: Select this option to allow a document preparer to set up the document for eSignature 
before sending it to the recipients. The Require eSignature(s) check box will still be available 

access_workflows_tab.htm
access_workflow_designer.htm
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on the Edit Action page. However, only the Prepare Document(s) for eSignature check box 
or the Require eSignature(s) check box can be enabled on a step action at a time. Once 
either check box has been selected, the other one will be greyed out and cannot be enabled.

 11. Select the signee's user role(s).

Note: All users within the selected role will have the ability to sign the document. To limit these 
users to the required signatories only, create a user role that includes only the qualified sign-
ees.

 12. Click Save.

Step 7: Add an Automation Step

An automation step must be placed at a point in the process after all documents have been signed. This 
step compiles the final document which includes all eSignatures and an encrypted certificate that solidifies 
it as a unique and final version of the document.

The end of your eSignature process should look similar to the highlighted portion of the diagram below:

To add an automation step to an eSignature process
 1. Go to the Workflow Designer.
 2. Drag and drop the automation step to the Workflow Designer.

The Edit Automation Step page is displayed.

 3. Complete all necessary fields and specifically:
 o Click the e-Signature File Download radio button.

 4. Click Save.

Step 8: Add a Conditional Step (Optional)

access_workflow_designer.htm
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Adding a conditional step that branches off of the automation step will help offset any unexpected errors. 
This optional step safeguards the process by ensuring that the final document is created by creating a loop 
that gives the process an alternate action if there are any unexpected errors. 

The conditional step will be similar to the highlighted portion of the diagram below:

To add a conditional step
 1. Go to the Workflow Designer.
 2. Drag and drop the conditional step to the Workflow Designer. 
 3. Complete all necessary fields.
 4. Click Save.

eSignature Workflow Troubleshooting Actions - for Adobe Acrobat Sign

While designing workflows with the eSignature process, it is important that you check that your workflow is 
valid and free from errors.

To validate your workflow
 1. Go to the Workflow Designer.
 2. Click the Error Check button.

Any validation errors found in your workflow will be displayed.
 3. Perform the following steps to resolve validation errors in your workflow:

Error Mes-
sage

Troubleshooting Actions

{Step Name} 
can be 

 o When using the Prepare document(s) for eSignature option, ensure that 
there is a workflow step configured for this. To do this, edit the workflow step 

access_workflow_designer.htm
access_workflow_designer.htm
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Error Mes-
sage

Troubleshooting Actions

reached 
without 
required 
actions: 'Pre-
pare document 
for eSignature
(s)' or 'Require 
eSignature(s)'

action for the actor responsible for tagging documents to ensure that the Pre-
pare document(s) for eSignature check box is selected (mandatory).

'Prepare doc-
ument for eSig-
nature(s)' 
action on {step 
name} requires 
eSignature 
'Destination 
file data field' 
configuration 
and Auto-
mated File 
Download 
Step

 o If the Prepare document for eSignature(s) check box has been selected 
for the Submit action on the data entry step, an automated file download step 
must be added to the workflow.

 

eSignature 
'Destination 
file data field' 
requires con-
figuration

For each file data field that will contain a document to be signed, ensure that you 
configure the Destination File Data Field settings correctly on the Data Field 
eSignature Settings section of the Data tab (Setup> Administration Tools> Pro-
cesses> Manage Processes>Click on a process name to view it).  

eSignature Workflow Troubleshooting Actions - for DocuSign

While designing workflows with the eSignature process, it is important that you check that your workflow is 
valid and free from errors.

To validate your workflow
 1. Go to the Workflow Designer.
 2. Click the Error Check button.

Any validation errors found in your workflow will be displayed.

access_workflow_designer.htm


Trimble Unity Construct

Page xv

 3. Perform the following steps to resolve validation errors in your workflow:

Error Message Troubleshooting Actions

{Step Name} can be 
reached without 
required actions: 'Pre-
pare document for 
eSignature(s)' or 
'Require eSignature
(s)'

 o Ensure that all the users who need to sign and approve the document 
are required to perform eSignatures. To do this, edit the workflow 
step action for each signing user and ensure that the Require eSig-
nature(s) check box is selected (mandatory).

AND

If using the new Prepare document(s) for eSignature option, 
ensure that there is a workflow step configured for this. To do this, 
edit the workflow step action for the actor responsible for tagging doc-
uments to ensure that the Prepare document(s) for eSignature 
check box is selected (mandatory).

 o On any possible path leading up to the document download step, at 
least one step actor must be required to e-Sign for the workflow to be 
valid.

'Prepare document for 
eSignature(s)' action 
on {step name} 
requires eSignature 
'Destination file data 
field' configuration and 
Automated File Down-
load Step

 o For each file data field that will contain a document to be signed, 
ensure that you configure the Destination File Data Field settings cor-
rectly on the Data Field eSignature Settings section of the Data tab 
(Setup> Administration Tools> Processes> Manage 
Processes>Click on a process name to view it).  

 o If the Prepare document for eSignature(s) check box has been 
selected for the Submit action on the data entry step, an automated 
file download step must be added to the workflow.

 o A validation error will be displayed if either of the above requirements 
are not met.

eSignature 'Destin-
ation file data field' 
requires configuration

For each file data field that will contain a document to be signed, ensure 
that you configure the Destination File Data Field settings correctly on 
the Data Field eSignature Settings section of the Data tab (Setup> 
Administration Tools> Processes> Manage Processes>Click on a pro-
cess name to view it).  

'Prepare document for 
eSignature(s)' or 
'Require eSignature
(s)' workflow requires 
these account pref-

 o An eSignature enabled workflow cannot be published without a 
DocuSign account.

 o If the 'Prepare document for eSignature(s)' or the 'Require eSig-
nature(s)' action has been added to the workflow, you need to setup 
your DocuSign credentials in Trimble Unity Construct as well.   
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Error Message Troubleshooting Actions

erence to be defined: 
DocuSignBrandID, 
DocuSign TraceOn, 
DocuSignPassword, 
DocuSignUsername

Contact Trimble Support to configure your DocuSign account set-
tings to work with your account in Trimble Unity Construct. 

Create Envelopes in DocuSign
With the DocuSign eSignature feature, you can send documents for signing by putting them in an electronic 
container called an envelope. 

Note: The actions that you may be able to perform in DocuSign are determined by the permissions profile 
set up for you in DocuSign. DS Sender or DS Admin profiles are required. Ensure that the eSignature work-
flow has been properly configured so that you can prepare electronic envelopes to and send documents for 
eSignatures.

Follow these steps to prepare and send a document for eSignature:

Step 1: Upload the file

Upload the document that requires electronic signature(s) to the process instance.

To upload and prepare a document for eSignature using DocuSign

 1. Click the Processes tab located at the top of the page.
 2. Choose a project from the All Projects menu.

The Project Processes page is displayed.

 3. Filter for the process whose details you want to view.
 4. Click the process number or subject of the process you want to access.

The Process instance page is displayed.

 5. On the Details tab, click Browse Computer or Browse e-Builder to search for the document. 
 6. Click Attach to upload it.
 7. Click Take Action.
 8. On the Prepare document(s) for eSignature page, click the Click here to prepare document(s) for 

eSignature link.

The DocuSign window is displayed with the document that was just uploaded.

Note: This must be done before moving the process to the next step.

Step 2: Add standard fields

Add standard fields to the document such as signature, initials, date signed and name. You can add them 
for each user that must sign the document.

To add standard fields in DocuSign
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 1. Open the document in the DocuSign window.
 2. From the recipients drop-down list, select the name of a user who needs to sign the document elec-

tronically.

Note: The recipients drop-down list will contain every user that can take action in the next step. 
This list will be defined based on the user role set for the user. When configured, eSignature work-
flows allow you to select a specific project member from the Selected Roles list to be the actor on 
the next step. These project members are added to the DocuSign Recipients list in eSignature 
steps.

 3. To insert a signature field for the selected user, drag and drop the Signature control from the left 
pane onto the document at the appropriate place on the page.

 4. Repeat this step by dragging and dropping other necessary standard field options like Initials or 
Date Signed onto the page. 

Note: Some of the other document fields you can add to the file are listed on the left pane such as 
the Name, Email, Company and so on.

Tip: DocuSign will retain the formatting such as the font size once you have set it for a certain 
field. This is useful when you need to add many fields of the same type such as multiple signature 
fields.

 5. To switch recipients, select a different user from the recipients drop-down list. Repeat the previous 
steps to add signature and other document fields for each user.

add_action_page_overview.htm#SelectedRolesList
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Tip: Click the Recipient Preview button to view a preview of the document as a particular recip-
ient. In the DocuSign preview window that is displayed, you can select a user name from the View-
ing as drop-down list to load their view of the document. Select the display format icons to see a 
desktop, tablet or phone preview of the document.

Step 3: Add external recipients (optional)

You can also add additional signees or document recipients who are external to e-Builder in this step. 

Note: Depending upon your DocuSign permissions profile, you may or may not have access to this fea-
ture.

Using the Edit Recipients option from the recipients drop-down list, external recipients can be added by 
entering their names and email addresses.   The document recipients from e-Builder are locked and the sign-
ing order is set to 1 by default. This is to  prevent inadvertent changes to the signing order as per the work-
flow. Any external recipients added using the Edit Recipients window will be set to a default signing order 
of 2. 

Note: It is important that you change the order to 1 for these recipients as well so that they receive the 
documents at the same time as the e-Builder users. If the order is unchanged and remains as 2, the doc-
ument will be sent to these external recipients only after the document has been signed by the last e-
Builder user in a given workflow instance.

To add external recipients

 1. On the DocuSign window, click Edit Recipients from the recipients drop-down list.
 2. On the Edit Recipients window, click Add Recipient to add a new row.
 3. Enter the external user's details in the Name and Email Address fields.
 4. Click Done to add the user to the recipient drop-down list.

Step 4 : Upload external files for eSignature (optional)

You can also add additional documents that are external to e-Builder in this step. 

Note: Depending upon your DocuSign permissions profile, you may or may not have access to this fea-
ture. Contact your DocuSign Administrator for further details.

To upload external files

 1. On the Documents pane of the DocuSign window, click the document settings icon  and select 
Edit Documents.

Tip: The Documents pane on the right displays the current document being prepared for eSig-
nature. You can also upload external files here.

 2. On the Upload a Document window that is displayed, browse for and select the required file from 
your computer and click Done. 

Tip: You can also choose to use a template or get the file from the cloud depending on your 
DocuSign account.
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Note: The uploaded file will be displayed in the Documents pane. You can add the signature and 
other document fields to it in the same way. This file will also be available on the Attached Docu-
ments tab of the process instance.

Step 5: Send the envelope

After you have finished preparing the document, you can send the envelope to the recipients.

To send the envelope

 1. In the DocuSign window, click Send to send the envelope and move the process instance on to the 
next step. 

Tip: If there are any missing fields for the recipients, you will be prompted to add them at this 
point. However, you are not required to add fields for every individual in situations where you have 
multiple recipients listed but only require specific individuals to apply their signature. You can also 
choose to skip this step and send the envelope without adding the missing fields. The users with 
missing fields will then be able to insert their signature anywhere in the document.

 2. Once the envelope has been created and sent, click Continue to move the process on to the next 
step.

Tip: To save the envelope as a draft that you can revisit later, click the Actions drop-down list and 
then click the Save and Close button. After preparing the document completely, you can send it 
out. To discard the envelope that you have created,  click the Actions drop-down list and then click 
the Discard button. You can then create a new envelope as required.

Create Agreements in Adobe Acrobat Sign
With the Adobe Acrobat Sign eSignature feature, you can send documents for signing by putting them in an 
electronic container called an agreement.

Follow these steps to prepare and send a document for eSignature:

Step 1: Upload the file

Upload the document that requires electronic signature(s) to the process instance.

To upload and prepare a document for eSignature

 1. Click the Processes tab located at the top of the page.
 2. Choose a project from the All Projects menu.

The Project Processes page is displayed.

 3. Filter for the process whose details you want to view.
 4. Click the process number or subject of the process you want to access.

The Process instance page is displayed.

 5. On the Details tab, click Browse Computer or Browse e-Builder to search for the document. 
 6. Click Attach to upload it.
 7. Click Take Action.
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 8. On the Prepare document(s) for eSignature page, click the Click here to prepare document(s) for 
eSignature link.

The Adobe Acrobat Sign window is displayed with the document that was just uploaded.

Note: This must be done before moving the process to the next step.

Step 2: Manage Recipients

Important: Acrobat Sign does not allow the removal of recipients once the agreement is no longer in 
Draft status, therefore it is imperative that any recipients who will not be necessary for a given process 
instance be removed initially. We also provide 1 placeholder recipient for each Require eSignature work-
flow step, for the possibility that the intended recipient is not a Current Actor when the workflow reaches 
their step. If keeping placeholders, a Name is required for each.

Remove Unnecessary Recipients or Add Names for Placeholder Recipients

 l Click the delete button beside a recipient name to remove any unnecessary recipients.
 l Enter a name in the Name field of each recipient row.

Guidelines to Tagging Documents with Placeholder Recipient fields

While preparing documents for eSignature using Adobe Acrobat Sign, you can now add placeholders recip-
ients when the exact signer is unknown. 

Adobe Acrobat Sign - Recipient placeholders 

The guidelines to tagging Documents with Placeholder Recipient fields for eSignature are as follows:
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 l Review all “Recipient” names to determine which recipients are needed for the specific Process 
instance.

 l The pre-loaded Recipients reflect every e-Builder user that is on a process step that requires e-Sig-
nature. Ensure that you do not edit or delete their “bounces” email addresses.

 l If there’s an eSignature step where the specific recipient is unknown, use the appropriate Place-
holder email for their step: “bouncesPlaceholder1”, ”bouncesPlaceholder2”, and so on.  

 o Consult with your Admin for guidance on exactly which placeholder number (1,2,3, etc.) cor-
relates to a particular eSignature step.

 o Locate the e-Builder users on that same step and delete them, leaving only the specific 
“bouncesPlaceholderN” emails for steps with unknown recipients.

 l Do not edit the remaining “bouncesPlaceholder” emails. 
 l e-Builder highly recommends that you add a name for each of the remaining Placeholder recipients 

to make it easier when tagging their signature location on documents.
 l Click Preview & add fields when done.

Step 3: Add external recipients (optional)

You can also add additional signees or document recipients who are external to e-Builder in this step. 

Add External Recipients

To add external recipients

 1. At the bottom of the Add recipients section, click the Plus + symbol and select Individual from the 
Recipients drop-down list.
A new signer row is added.

 2. Enter the external user's details in the required Emailand Name fields.
 3. Repeat the steps as needed for each additional external recipient.
 4. Click Preview & add fields to add the user to the recipient drop-down list.

Step 4: Add Form fields
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Add Form fields to the document such as signature, initials, date signed and name. You can add them for 
each user that must sign the document.

Add Form Fields

To add recipient Form fields to an agreement

 1. Click Preview & add fields.
 2. From the recipients drop-down list, select the name of a user who needs to sign the document elec-

tronically.

Note: The recipients drop-down list will contain every user that can take action in the next step. 
This list will be defined based on the user role set for the user. When configured, eSignature work-
flows allow you to select a specific project member from the Selected Roles list to be the actor on 
the next step. These project members are also added to the Recipients list. Additionally, there is 
one placeholder recipient for each step that has a Require eSignature action configured.

 3. Add the e-Signature or Initials Form Fields to the required locations in the document. Additional 
options to change the field type and customize the field are available by right-clicking on the field.

add_action_page_overview.htm#SelectedRolesList
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Additional Options for Form Fields

Step 5: Send the agreement

After you have finished preparing the document, you can send the agreement to the recipients.

To send the agreement

 1. In the Acrobat Sign window, click Send to send the agreement.

Tip: If there are any missing fields for the recipients, you will be prompted to go back and add 
them at this point. However, you are not required to add fields for every individual.

 2. Once the agreement has been created and sent, click End session to return to the action.
 3. Click Continue to move the process on to the next workflow step. 

Electronically Signing (e-Sign) Documents 
Once a process step is configured with a signing action, this action will be listed in the Action drop-down menu 
for you to select.

Note: Only PDF files can be electronically signed.

To electronically sign a document in Adobe Acrobat Sign
 1. Open the Process Instance page.
 2. Complete all necessary fields.
 3. Click the Action drop-down arrow and select the signing action.

Note: Step names are configurable; therefore, the name of this step will be different for every 
user.

 4. Click Take Action.
A message prompting you for an electronic signature is displayed.

working_with_processes.htm#To
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Note: You are not required to click the Take Action button if the process has been configured to 
allow the action to take place by simply making a selection from this drop-down menu. For more 
information on this setting, see Workflow Properties Page Overview in the Online Help.

 5. Click the link, Click here to review and sign your document(s).
 6. Click Continue to agree to Adobe's terms of use. 

This opens an agreement signing session in Adobe Acrobat Sign.

 7. Click Start to navigate to the location where your signature is necessary.
 8. Click to sign at each e-Signature location in the agreement. 

workflow_properties_page_overv.htm
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 9. Select Apply once you determine your preferred method to e-Sign. You can type your name, draw 
your signature or select a signature image from your computer or use your mobile device to easily 
draw or capture your signature.

Type Name Option

Draw Signature Option

Select Signature Image Option

Use Mobile Device Option
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 10. Click the Click to Sign button to end the signing session. 

Ending the Signing Session

A success message will be displayed on the e-Builder page.

 11. Click Continue to complete this step and send the process to the next workflow step.

To electronically sign a document in DocuSign
 1. Open the Process Instance page.
 2. Complete all necessary fields.
 3. Click the Action drop-down arrow and select the signing action.

Note: Step names are configurable; therefore, the name of this step will be different for every 
user.

 4. Click Take Action.
A message prompting you for an electronic signature is displayed.

Note: You are not required to click the Take Action button if the process has been configured to 
allow the action to take place by simply making a selection from this drop-down menu. For more 
information on this setting, see Workflow Properties Page Overview in the Online Help.

 5. Click the link, Click here to review and sign your document(s).
 6. Click Review Document.

The file opens in DocuSign.

 7. Review and locate where your signature is necessary.
 8. Drag and drop your signature from the Signature Context menu.

Note: This context menu displays by default, but should you need to reopen it, click the pencil icon 

.

 9. Click Finish.
You are prompted for confirmation.

 10. Click Yes.

working_with_processes.htm#To
workflow_properties_page_overv.htm
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A success message displays on the e-Builder Process Instance page.

 11. Click Continue to complete this step.
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